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1. What is Daisy?
Daisy (Data Analysis Interactively) is unique.

Daisy is a graphical analysis and interactive investigation program for all databases.

Daisy searches for the hidden links between records in your databases and shows them as a circular Daisy Chart.  This enables you to find the underlying patterns and rules, that control your business, your research, your problems or perhaps even your life.

Daisy is also a powerful qualitative statistical program, that can process and display the numeric, date and time fields in a database as a circular histogram on the Daisy Chart, that allows powerful comparisons to be made.

Daisy can also publish the many forms of charts it creates as HTML charts, which can be uploaded to the Internet or an organisation’s Intranet.

Daisy Charts exhibit a characteristic picture for a particular database, giving early and quick indication of any change in the form and relationships of the data.

1.1 Active Charts

Daisy is all about Active Charts.

Active Charts have unique properties when compared to the normal passive charts drawn by most programs.
They are fully scalable in much the same way as a map.  The chart can be zoomed and panned so that important features can be seen in more detail.

As the chart is zoomed, lines and text are reduced in size proportionally, so that the chart becomes more information rich.
Click on the chart and the underlying structure is revealed.  Records, nodes and links in the database can be shown as tables or Daisy Grids.

1.2 Daisy, the Internet and HTML Charts

Daisy now has the capability of transforming a Daisy or other chart and the underlying data into what is called an HTML Chart.

An HTML Chart consists of a series of HTML Pages and a graphical image of the Daisy Chart stored as a Chart Image file.  They are all linked together, so that you can explore the chart solely by the use of the mouse.  Just as you would the World Wide Web!

These HTML Pages can of course be uploaded to any web site. No other files or special servers are required.

1.3 Data Input to Daisy

Data can be accessed from most common databases and spreadsheets, such as Microsoft Access, Excel and FoxPro, and dBase, in addition to a comma separated file (CSV) form.  All the data in the examples in this Manual were accessed in the latter way.

Daisy can also read the Log Files  produced by a Web Site.  These files can be in either the common or extended format, as laid down in standards for the World Wide Web.

Daisy can also read any database that can be accessed using Microsoft ADO.

Note that Daisy does not change any data in the source database or file.

1.4 The Preferred Method of Data Input
As our own and our customers experience with Daisy has grown, a preferred philosophy of handling databases has developed.

Because Daisy reads the database extensively and because it needs access to the whole database so that it can visualise everything, Daisy should always work on its own copy of the data.  For this reason, databases are nearly always copied from their native format to a simple comma separated form, which can be read quickly and easily by Daisy.

The only exceptions are Microsoft Excel, where Daisy can read the worksheet directly, but again only if no other user or program is reading the data at the same time and a Web Site Log File, which is in effect a simple text file of a fixed format.

1.5 The Daisy Chart
The Figure on the next page shows a typical Daisy Chart produced from the Newmarket Winners example data delivered with Daisy.  This data is all the winning horses at Newmarket in England during 1992.  (The data is by courtesy of Newmarket Racecourses Trust.)

Daisy Charts are characterised by nodes or boxes, which are obtained by mapping fields in the database, and links which are drawn between values in the same record.

The three groups of nodes, show Jockeys, Trainers and Owners, respectively arranged in order of decreasing Prize Money.  This ordering puts the most successful at the head of the group.  The histograms drawn on the nodes indicate a comparison of success between individuals.  Red shows the number of races won and green the prize money.

The links drawn between the nodes denote how successful the combinations have been.  (The darker the line, the more Prize Money won!) 

In this example all of the nodes are mapped by simply taking their text values; L Piggott, Pat Eddery, etc.  Data can also be mapped as dates, times and numerics, as well as many other text formats.  As an example, if the database contains a date and time, then it can be mapped by Day of Week and Hour.  See the Software Test Example in Section 1.7 for a simple illustration of this very powerful technique, that should be used on all databases of this type.

Note the dark triangle.  This was because the jockey, Lester Piggott, the trainer, Peter Chapple Hyam, and the Owner,   Robert Sangster, had a fabulous year.  They may not numerically have won many races, but they did win three of the biggest!
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The Daisy Chart
This Daisy Chart was produced using the Prize Money Example
The full power of Daisy is realised when histograms are added to each node.  Calculations or aggregations from an extensive library, can be performed which further augment the power of the analysis.

The two histograms in the example show the Number of Races Won (green) and the Prize Money (cyan).

1.6 Investigating the Daisy Chart
Consider a small area of the Daisy Chart shown on the previous page expanded by using the built-in zoom.  This would be used to investigate an area of the chart.
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Note that the text in the node boxes has increased in size as the Daisy Chart has been enlarged, but only by the square-root of the zoom ratio.

Note too how the links become much clearer and you begin to recognise characteristic patterns in Daisy Charts associated with your data.  These will change as the database changes, so drawn periodically, Daisy Charts will give early indications of any problems or improvements in your data or your business.

Daisy Charts can also indicate that each of the mapping fields in your database is independent.  If all the links show is an amorphous morass, then you have no correlated factors between the chosen fields and you can treat each individually.

A Daisy Chart is also a good indication of whether you have enough data to make any sensible deductions.  If the only links across a chart are sparse and of the same strength, then this is often indicative, that either the wrong fields are being mapped or there are not enough records.

All of these possible conclusions are possible because of the unique form of a Daisy Chart.  All of the date, time, text and numeric data is shown on one simple chart, which is a true fingerprint of hidden characteristics of the database.  If the underlying structure changes, then so does the Daisy Chart.

1.7 Date/Time Daisy Charts
Shown on the next page is a simple analysis of attempted connections with a new piece of software to the Internet.  As each connection was made it was entered into a simple database and the Daisy Chart shows how failures occurred in a pictorial form.

The field, Date in the database is mapped using the powerful Day of Week mapping.  Each field is taken in turn and turned into Sunday, Monday, Tuesday etc.  These are then drawn in ascending order.

The field, Time is mapped in a similar way using Hour.  Thus 10:16 will be mapped to the node named 10.
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Date/Time Daisy Chart
This Daisy Chart was produced using the Software Test example

The field, Connect is also mapped using a special numeric mapping called Partition.  A step value is entered which sets up nodes with values such as 0 to 5, 5 to 10, 10 to 15 etc.

This type of Daisy Chart has many different applications.

A Engineering Company found that one purchasing clerk was placing a lot of his orders at strange times.  Why?

A Transport Company used this type of analysis on all the faults in it's network.  Changing of maintenance procedure and management changes resulted in significant savings.

A Telephone Company found that a large number of fraudulent calls were made from a specific town, on a particular day of the week and time.  This very much narrowed the search and an arrest was quickly made.

It is always recommended that any date and time-based data is plotted in this type of Daisy Chart.

1.8 Daisy and Data Access
As well as showing the data relationships, Daisy is a simple but extremely powerful program for accessing data matching a particular attribute.

For instance in the example shown, it might be needed to display or print, all records that meet a particular criteria, such as which winners were ridden by a Jockey called Lester Piggott. 

Just click on Lester's node with the mouse, click on Records in the menu and a Daisy Grid will show all of his winning rides.
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Whilst these grids are displayed, the mouse can be used to move around the records investigating the data. Click on the scroll-bars and different fields or records will be shown.  Double-click on any record and the whole record will be displayed.

Note how the One, Sort, Save, Print etc. buttons can be used to process the selected grid. 

1.9 Printing the Daisy Grids
Print is a very quick way of printing a grid, that meets a specific criteria.  And all without using the keyboard!

Various formats are available, with titles, fonts and styles being changed by a simple dialog. 

1.10 Editing the Grids
The grid can’t be changed except that areas can be selected and these can then be kept or deleted.  This is a simple way of reducing the grid to the data you want printed.

Note that Daisy only holds these changes whilst the grid is displayed and does not change the original data in any way.
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Shown is the right click menu of the grid, which is used to perform the deletion.

The Save command allows the data to be exported as a comma separated file. 

1.11 Successive Daisy Analyses
Notice the Daisy... button in the Daisy Grid shown on the previous page.  

Larger versions of Daisy from Daisy Lite Plus upwards have the feature to call the program again on the data contained in the Daisy Grid. 

1.12 Multiple Selections and Visual SQL
Daisy has the ability to perform multiple selections using only the mouse.  After using any of the Point and Click commands, just click on a selection of nodes and the record or node data, linked to the choice will be displayed in a grid.

This has been called 'Visual SQL', in that it allows a simple visual selection to mimic the complicated selection statements in SQL.

1.13 Daisy and Microsoft Excel
All versions of Daisy can also use Microsoft Excel to hold the grids.  This adds the enormous power of Excel to that of Daisy.
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Note in this example that three Jockeys have been added to a single Microsoft Excel workbook.  This simple technique of collecting different Daisy Grids or views, is used by several companies to 'cut and slice' a large mainframe database into small manageable chunks.  

These can then be distributed in Excel format by E-Mail to those at the sharp end, who only need simple Microsoft Office skills.

1.14 Summaries and Duplicates
In most Daisy Charts, each of the mapping fields is used to create a separate set of nodes.  Thus, if there are four mapping fields, then there will be four arcs.

However, an option in Daisy allows the mapped data to be combined into a single mapping field, before the chart is drawn.

This feature is used in the creation of summary reports and the searching for duplicate records in a database.

1.15 Other Chart Types

The two charts shown were all produced by Daisy.

The first is a matrix style chart, based on the Software Test example.

The second is a chart, which shows the range of values in boxed histograms.


[image: image7.png]s R e
s ol o
nyL
pan
any
uow
ung ol s N
B Fa =R i
08 8L JO AEQ

Hour





The Daisy Go-Matrix Chart
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The Daisy Boxed Histogram
1.16 But I don't know anything about Horse Racing!
The Newmarket data was chosen for some of the example because it is rich data, with text, dates, times and numeric values. 

It is also data that is in the public domain and isn’t covered by the Data Protection Act!

It is data that is familiar to many and the conclusions you might make can be easily verified.  Remember, it is absolutely essential to check any technique, before applying it to your data.

The techniques applied to the racing database can be applied to virtually every database, no matter what it contains.  Sometimes, you will find things that you know are there, but in many cases, you will uncover things that you did not even suspect.  You will always gain a greater insight into the data.

2. Versions of Daisy
There are a wide range of versions of Daisy for all users, systems and purposes from the smallest, simple application to ones that are multi-user and multi-database, with very comprehensive mining, analysis and reporting.

Note that Daisy 2003 only works in Windows later than ’95, although 2000, NT or XP are recommended.  It will work with all future versions of Microsoft Windows.

All versions of Daisy 2003 are available electronically, but they can be supplied on CD-ROM if required.

2.1 Daisy 2003 Lite 

This is the smallest version of Daisy, that has a reduced set of features.  It can only read simple comma separated files or Microsoft Excel workbooks as databases, up to a limit of 10,000 records.

Daisy 2003 Lite does contain the ability to use Microsoft Excel to handle Daisy Grids. 

2.2 Daisy 2003 Lite Plus 

This is a larger version of Daisy 2003 Lite, that has an increased set of features and also includes the Web Site Log File capabilities.  The limit is now 1,000,000 records and 10,000 nodes, which make this version ideal for processing large name and address databases.

2.3 Daisy 2003
This standard version of the program, Daisy 2003, is another substantial upgrade.  The following extra features have been added.

Databases can be opened using Microsoft ADO.

Profiles that enable all settings and templates to be saved together

HTML Charts that can be distributed over the Internet or an organisation’s Intranet.

This version can be driven using ActiveX technology, so you can create your own applications.

The Internet can be searched using the results of Daisy Charts.

Etc. etc.

The limit is now 10,000,000 records and 100,000 nodes
These features are described in Section 11 onwards.

2.4 Daisy 2003 Version Summary
The following table summaries the various versions of Daisy.









Lite
Plus
2003
Input Databases:
  Comma Separated Files



Yes
Yes
Yes

  Excel Workbooks




Yes
Yes
Yes

  Web Site Log Files



No
Yes
Yes

  Microsoft Access




No
No
Yes

  Microsoft FoxPro




No 
No
Yes

  dBase





No
No
Yes

  ADO






No
No
Yes

Limits:
  Records – Comma Separated


10K
1M
10M

  Records - Web Site Log Files


30K
1M
1M

  Records - Other Databases




10M

  Nodes - Calculation



10K
10K
100K

  Nodes - Display




10K
10K
100K

  Links





10K
10K
100K

Daisy Grids:
  Can be stored in Excel



Yes
Yes
Yes

  Maximum Grids




5
10
20

  Maximum Investigation Windows

2
5
5

  Maximum Records Display


10K
10K
20K

    - In Excel





10K
65K
65K

  Grid Daisy Button




No
Yes
Yes

  Grid Deletion




No
Yes
Yes

Features:

  Fast Algorithm




No
No
Yes

  HTML Charts




No
No
Yes

  HTML Page Editing



No
No
Yes

  Mapping/Aggregation Fields


10
10
15

  Marks for Nodes and Links


No
Yes
Yes

  Multiple Runs




No
Yes
Yes

  Notes in Printed Charts



No
Yes
Yes

  Profiles





No
No
Yes

  Save Chart





No
No
Yes

  View One Per Page



No
Yes
Yes

  View Web Pages




No
No
Yes

3. Installing and Running Daisy
Daisy is a Windows program and needs to run with at least version 95 or NT of that program on a more than adequate computer, with about 100 Mb of free space.

Daisy is installed in the standard way for all Windows programs.  

Full instructions for the version you have purchased or downloaded are contained in the readme file that comes with the program. 

3.1 Thirty Day Free Trials
All versions of Daisy are available on a 30-day Free Trial.

Just enter your registration details on the Daisy Analysis Web Site at www.daisy2000.com and into the program and you will be able to run any version of Daisy without obligation.

Once Daisy Analysis has received payment for the software, you will be sent registration and user codes that allows unlimited access of the software.

In the free-trial only the features of Daisy Lite are available.
3.2 Installing a Downloaded Version of Daisy 2003
This shows the sequence for the installation of Daisy 2003, which will have been downloaded as the file, Daisy2003Setup.exe.  

Note that there is only one download for all versions of Daisy from Lite to 2003.

Typically, this file will have been stored in a directory such as c:\Download\Daisy.  (Don't worry though if you forget where you put it, as Daisy Analysis set no limits on the downloading of versions of the software.  So you can always download another!)

Locate the file with Windows Explorer and double-click the file, Daisy2003Setup.exe.  The install program, InstallShield (as used by nearly everybody else!), will ask you for the install password for the file.  This password will have been E-Mailed to you when you downloaded the software.  (Note that Daisy Analysis used to allow unrestricted access to the downloaded files, but got fed up with people, who downloaded without registration.)

Answer all of the questions from the install program, taking care to make sure you install Daisy, where all other programs are stored on your computer.  Typically, Daisy 2003 will be installed in the directory, c:\Program Files\Daisy Analysis\Daisy 2000.  

Note that the directory is 2000 and not 2003!  This is so that all versions of Daisy are stored in the same place!

If you are installing an upgrade, then always install the upgrade over the original files.

3.3 Installing a CD-ROM Version of Daisy 2003
To install a CD-ROM version of Daisy 2003, just run the appropriate Setup program on the CD-ROM.  The actual directory and program name are detailed on the CD-ROM case.

3.4 Internet Explorer

Daisy needs version 4 or later of Internet Explorer to be installed.

It is used for the Help.

3.5 Running Daisy 2003 for the First Time
Choose Daisy 2003 or the appropriate program from the Daisy 2003 Program Group or directly from the desktop.

On a first run of Daisy, the message shown below will be displayed.
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If you don't register Daisy, you will only be able to use the features of Daisy Lite. Others will be unavailable.

3.6 Registering Daisy

Before unlocking the program to install it, you will have registered Daisy, as this is the only way to obtain the install password for the install program.

When you have paid for your required version of the program, you can then enter your registration and user codes.

Do this using Register Daisy in the Help menu.
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Note that the codes for all versions of Daisy are entered using this command.

3.7 Getting Started

Shown is Daisy, when started for the first time.
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Note the Help at the right of the screen.

It is recommended that Get Started Now! at the bottom of the Help is clicked

Some of the sections displayed will now be covered.

3.8 Help

The Help in Daisy has been considerably extended since previous versions.

A floating help window has been added, which enables Help to be called from every dialog in Daisy.

Learn how to use the toolbar to navigate the Help, print pages and search for particular words and phrases.

3.9 Spelling

By default, English spelling is used.

This can be changed using Help Configure in the Help menu.  Just click either English or American buttons.

3.10 Daisy Examples
A feature of Daisy is the ability to open one of several example databases and draw simple Daisy Charts.

Use Open in the File menu, choosing the Example… sub-command, which will display a dialog from which the example is chosen.
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Just choose an example and a Daisy Chart will be drawn automatically.

It is recommended that several of these examples are drawn. 

Shown is the Software Test example selected in the dialog.
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Note the Help has been set automatically to something that explains the example.  This can be done with any Daisy Chart.

4. Using Daisy
Daisy is a Windows program and needs to run with at least version 95 or NT of that program on a more than adequate computer, with about 100 Mb of free space.

4.1 Running Daisy
Choose Daisy or from the Daisy 2003 Program Group in the Windows Start Menu or the Daisy 2003 icon from the desktop.  

Running Daisy 2003 for the first time was described in Section 3.4.

Daisy automatically configures itself to the version you have installed. Thus, if you have Daisy Lite installed, some commands, such as profiles, and some databases, like ADO, will be unavailable.

Daisy also saves settings between runs of the program.

Data saved includes, your preferences for such things as directories, Help, toolbar, chart setup etc. and the last few databases that have been opened.

Note that you can run Daisy Lite Plus and Daisy 2003 more than once at the same time.  Daisy Lite is limited to a single instance of the program.

4.2 A Windows Program
All Windows programs are effectively multiple entry.  

You can jump into the commands at any point, by just clicking on a menu or menu item, a control such as a button or a check box, or even on a point of the screen.

4.3 Help and the Daisy Reference
The Reference Section for this Manual, is now provided in the Help.  Just go to the Index and locate the topic you require.
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Just click the required topic in the Index for more details.

? buttons are also available in most dialogs, which can be used to provide additional Help.
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The dialog shown is used to change the chart size.  Note the ? under Cancel.

Note that all words shown in bold in this Manual are entries in the Help.

4.4 Data for Daisy
The standard form of data for Daisy is the comma-delimited or comma separated file. 

The format required for Daisy is described under CSV File in the Help.  (Note that all of the example files for Daisy were created using Microsoft Access.)

The database is opened using Open Database in the File menu or by using the Open button in the toolbar.
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Comma/Tab Separated File has been selected.

The same command has been selected from the Open button menu.
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The dialog that is used to open the actual file is shown below.
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Note how various options can be set to cater for different forms of comma and tab-separated files.

4.5 Viewing the Data
Once the database has been opened, commands in the View menu can be used to display and investigate the data. 

Use Database Properties in the File Menu to check the database field names and other properties are as expected.
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The simple View All Records or View First 20 Records should also be used to determine if the database is being read correctly.  The data will be displayed as a simple grid or in Microsoft Excel.

Shown are the first few records of the SoftwareTest example, supplied with Daisy.  This has been viewed as a Daisy Grid.
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Note the buttons in the toolbar at the top of the Daisy Grid.

These buttons vary according to the version of Daisy.  They include :-

One - Shows one record in the grid

Find - Finds data in the grid.

Sort - Sorts the data into another order, based on any of the fields in the grid.

You can also double-click the heading of a column to sort on that column.  Click again and it inverts.

Save – Save the data in the grid to a file on disc.

Print - Prints the data in the grid.

Daisy - This calls up a second copy of Daisy and runs it with the data in the grid.

Always check the data with View before attempting to draw a chart.

4.6 Chart Drawing Window

Daisy can create charts of various sizes to suit your application.

The size is controlled by Chart Size in the Options menu.
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When the size chosen is bigger than the size of the window available, scroll-bars are shown as in the figure on page 22.
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When they are not the area surrounding the chart is shown in yellow.

4.7 Right Click Menus

In Daisy you can use the right mouse button to call up additional menus to perform extra actions and tests. 

For instance, in a Daisy Grid this technique brings up a sub-menu, which gives a fast access to the more important commands controlled by the buttons.  Here the sub-menu has been called with several rows selected in the grid.
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Choosing Delete Rows will remove the selected rows from the grid.

Note that Status is the quick way to find the size of the Daisy Grid.
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Right click menus are also available in the main chart drawing window.

5. Building a Daisy Chart
Essentially, building a Daisy Chart is a simple process, whereby several fields in the database are selected, their mapping types, format and order are defined, and the various nodes and links are then calculated and drawn.

A special command, Quick Chart Setup, is provided in the Draw menu, which can be used to create Daisy Charts in a simple conversational manner.  Always use this command on opening a new database.  

When called a dialog will ask whether you want to create a chart or use a template.
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The buttons on this dialog are as follows :-

Quick Draw is used to create a new Daisy Chart, using a conversational dialog.

Everything will be reset and after setting the parameters, these can be saved in a template, before drawing the chart.  This process is described in detail in the following sections.

Draw Chart is for experiences users and is used to setup the chart directly.

Get Template will search for templates, where all of the fields in the template are available in the current database.  

One is then chosen from a dialog box.

Note that it is always a good idea to define templates, as this greatly increases the power of Daisy.

Tip
Remember too, that a typical user is often analysing lots of databases, with the same format.  If a set of templates have been defined, then it is a simple action, with the Get Template button to locate every template that can be used directly on the data.

5.1 Quick Chart Setup
After clicking on the Quick Draw button, a dialog asks which type of chart, you want to create.
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As each type is selected, the dialog box gives brief notes on the chart and the Help gives a fuller explanation.

As the database we have chosen for this example is Software Test, we will draw a Date and Time version of the Daisy Chart. 
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Note how the sample picture has changed in addition to the notes.

Note that a Date and Time chart is based on mapping one date field as the Day of the Week and a time field as the Hour.

5.2 Mapping, Mapping Fields and Mapping Formats

Mapping is the process of translating the database into the Daisy or other chart, by grouping fields with the same characteristics at nodes.

Two definitions are important :-

The mapping format is the method, function or operation applied to a field to turn it into the node value. 

The mapping type is either Text, Date, Time or Numeric, depending on the type of the mapping format to be performed.

Consider the example, where a field, Fault, is mapped with a mapping type of Text and a similar mapping format.  For each different value of the field, a new node will be created in the chart in the arc corresponding to the mapping field, Fault.

Tip 
It is recommended that you read the rest of this section very thoroughly!
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Choosing a suitable mapping format can at first sight appear to be a difficult and challenging process.

There are around 100 mapping formats in Daisy, where some are much more obscure than others. Which ones are best? Which ones do I use? etc. etc.

Take a simple example of mapping say the transaction value in a shop, such as a supermarket. This will have lots of different values, such as 76.24, 23.45, 123.00 etc.

Given say 1,000 or so transactions, there is likely to be almost as many different values.

So mapping the data using the obvious mapping format of Numeric is probably not a good idea.

Tip
Never choose a mapping format that will result in thousands of nodes unless that is exactly what you intend. You won't learn much in most cases!
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team and the results show in the number of races they win
together. All of the races involved can be displayed by a
simple clicking of the nodes.

Note too the link, between Michael Hills and Michael
Bell. A there is no dominant Owner involved, this
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A better approach is to choose a mapping format that will result in a manageable number of nodes. Typically, this is less than 20, although if you have a large screen, then up to 50 might be easily visualised.

Three mapping formats can achieve this :-

Break - Numeric is used to create up to five nodes with break values separating each.

Partition is used to split the data according to a step value. In our simple example, 10 might be suitable.

Tens extracts the tens from the data calling the nodes, 0, 10, 20 etc.

Tip 
Always use a mapping format that creates a limited set of nodes.
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Our example used a numeric value.  But what about dates, times and text? 
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Date mapping formats should be chosen so that a manageable number of nodes is generated.

Recommended mapping formats are :-

Break - Date does for dates what Break - Numeric does for numerics.

Day of Week maps the date as Sun, Mon, Tue etc.

Year-Month maps the date as something like 1996-Mar. This order is better than Mar-1996 as the nodes sort more readily into the correct order.
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Recommended Time mapping formats are :-

Break - Time maps times to up five nodes.

Hour maps the time as 0, 1, 2 etc.

Tip
Use Hour with the related Day of Week to analyse date and time based databases for significant patterns.
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to select the required records from the database

‘The real benefit from this type of analysis comes, if the
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Note tht this Data Sheet was produced totally in Daisy
2000 using the built-in mini-word-processor to add these
notes to a standard Daisy Chart.
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colour printer. And working at normal not presentation
print quality!

Daisy is available from
James Miller, Daisy Analysis Ltd,, East Green Farm, Great Bradley, Newmarket, Suffolk, CBS 9LU, UK

Tel: +44-(0)1440-783789

Fax: +44-(0)20-7681-2369

Internet: www.daisy.co.uk




Recommended Text mapping formats depend very much on the data being mapped.

For instance if you are mapping names and addresses then Street Number and Street Name can be very useful.

Other useful Text mapping formats are :-

First Character, First Word, Last Word etc. are used to extract relevant parts of the text.

Phone Area, Phone Country, Phone Exchange and Phone Number are used to decode and format both nation-wide and International phone numbers.

Soundex is used to analyse names that sound alike.

This mapping format is based on the Soundex technology developed in the 1920’s to analyse census data in the United States.

Don't forget that with the simple mapping format of Text you can specify a width and a start position to map specific parts of the data

.
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‘The Daisy Go-Matrix Chart is a graphical representation of the calls made whilst testing anew software program, that
downloads E-Mail from the Internet
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‘The data has been analysed into a matrix of nodes with axes of Date as Day of the Week and Time as Hour. Two
histograms are drawr, green showing the Number of Connections and cyan the Number of E-Mails
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In Daisy 2003 an extra set of Tests mapping formats have now been added.

These test values and return True or False according to the value of the field and any criteria entered.

Some are straight validity tests such as Test Numeric Valid, Test Date Valid etc.

Others test values against simple properties such as Test All Alpha, Test Non-Zero, Test Negative etc.

Others tests against entered values such as Test Contains, Test Equals etc.

Don't underestimate the power of this set of tests in validating a database and also in performing simple checks that locate records outside of acceptable criteria.
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Daisy Chart. This enables you to find the underlying
patterns and rules, that control your business, your
research, your problems or perhaps even your life.
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Daisy Charts can show all o part of your database as a
single chart, with all of the underlying data linked to the
image. This enables the datato be selected, displayed,
printed and processed, solely by using the mouse.

Daisy is also a qualitative statistical program, that can
process and display the numeric, date and time fields ina
database as a circular histogram. This allows powerful
comparisons to be made and linkages between factors and
trends to be deduced and analysed

Daisy is an affordable Windows-based program (Versions
start as low as £ 991), that runs on all IBM compatible
PC's, using Windows 3.1, 95, ‘98 or NT.

‘This Daisy Chart shows a typical analysis of long
telephone calls. Note that both the number of calls and
their total duration are shown as histograms
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Remember though that the reason Daisy has a lot of mapping formats is that there are a myriad number of ways that databases can be analysed.

Go forward and experiment!

5.3 Continuing the Quick Chart Setup – Mapping Fields

Returning to the Quick Chart Setup and the example, when OK is clicked, the dialog changes and you will be asked to select the field to be mapped as Day of the Week.
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Note how the field is automatically previewed when it is selected in the list.  The mapping is not applied in the preview.  

Try using preview on a non-date field.  Values will be shown, that obviously can’t be mapped using a date mapping format, such as Day of the Week.

The time field is then selected.
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Two fields, Date and Time have now been selected.

Date will be mapped with a mapping format of Day of the Week, whilst Time will use Hour.

Once these two fields have been chosen the full Quick Draw Chart dialog is then shown.
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Note :-

The two fields, Date and Time, have been added to the dialog with the appropriate mapping formats.

As Date is selected, note how it is previewed.

Aggregation Fields is used to setup the fields to be aggregated.

Chart Drawing Limits sets any limits to be applied.

Histograms sets whether histograms are to be added to the chart.

Title sets a title to be shown in the legend for the chart.

Extra mapping fields are adding by selecting the fields in the pull-down lists and then selecting the format accordingly.
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Connect has been mapped using Partition with a step value of 10 and Fault is mapped as simple Text.

This example shows the use of four of the most common mapping formats, Day of the Week, Hour, Partition and Text.

[image: image126.png]Daisy Example 3

Printed directly by Daisy on a Hewlett.
Packard colous printer.

Delays on the London Underground =

‘The Daisy Chart is a graphical representation of all the
incidents that caused delay on the various lines of the
London Underground in March 1996,

‘The data has been analysed into three sets of nodes, each
of which is shown as an arc chart. These are the line, the
day of the week and the area that caused the delay.

Two histograms and their values are shown on each node;
the actual number of incidents (green) and the total delay
in minutes (cyan).

‘The lines or links between the nodes show the relative
strengths of the connections between nodes. In this Daisy
Chart, they are shown in terms of the total delay. The
widest links are the strongest.

At afirst glance, it would appear that there were serious
delays on the Jubilee Line on Mondays, involving
stations and safety. By using the mouse to select the
delays involved, it was found that they were due to the
closure of two stations because of unsafe floors for
several hours. This. although more than an inconvenience
to passengers at those locations, did not cause any danger
or affect the overall running of the network

Other strong links show power and track problems on the
Northern Line. These are currently being addressed ina
multi-million pound total re-equipment of the line.

Note that most of the other links are weak, which indicates
that delays are of a randorm nature and not due to
systematic management, staff and equipment failures

Daisy is available from
James Miller, Daisy Analysis Ltd,, East Green Farm, Great Bradley, Newmarket, Suffolk, CBS 9LU, UK

Tel: +44-(0)1440-783789

Fax: +44-(0)20-7681-2369

Internet: www.daisy.co.uk




For more information on mapping, see Mapping in the Help for Daisy.
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There are several topics, which it is recommended are printed and read!

5.4 Aggregation, Aggregation Fields and Aggregation Types

Aggregation is the process, where values from the records in the database, that correspond to a particular node, are totalled, averaged or otherwise processed. They are then stored along with other details of that node.

A typical aggregation might calculate the total of a particular field in the records associated with each node.

In this case the aggregation type would be defined as Total and the whole calculation is referred to as the aggregation field.
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Daisy Charts and Web Site Analysis

Daisy (Data Analysis Interactively) is unique.

Daisy was conceived by James Miller, to bring advanced
data mining and analysis techniques to the PC.

Daisy is a graphical analysis and interactive investigation
program for all databases, for all companies, organisations
and individuals

Daisy is ideal for searching for patterns in the use of Web
Sites, reading the log files directly and displaying them as
aspecial form of circular chart, called a Daisy Chart.
‘This helps you to define the underlying changes, thinking
and rules, that drive your business and its customers.

‘The Daisy Chart shown here is atypical Daisy Date/Time
analysis, with the Pages, their Type and the Download
Status also shown. The two hisfograms on each node,
show the Number of Downloads (green) and the Bytes
Downloaded (magenta).

Drawn every day, week or month, this simple Daisy Chart
is an important tool in the management of your Web Site

Daisy is an affordable Windows-based program (Versions
start as low as £ 991), that runs on all IBM compatible
PC's, using Windows 3.1, '95, '98 or NT. Most versions
can read industry-standard Web Log Files directly.

Daisy is available from
James Miller, Daisy Analysis Ltd,, East Green Farm, Great Bradley, Newmarket, Suffolk, CBS 9LU, UK

Tel: +44-(0)1440-783789

Fax: +44-(0)20-7681-2369

Internet: www.daisy.co.uk




Recommended aggregation types are :-

Total which totals the values at a node.

Average, Largest and Smallest find averages, the largest and smallest values respectively.

Other aggregation types can count the number of records at a node that meet specific criteria, whilst others perform arithmetic on previous aggregation fields.

5.5 Continuing the Quick Chart Setup – Aggregation Fields

An aggregation field can also be added using the pull-down lists.

[image: image31.png]Quick Draw Chart - Daisy Chart

~Mapping Fields——— —Aggregation Fields
Fields: Formats: Names: Types: Data Fieldt O
Date ~ | [Day ofweek ¥ [Totall [wail =
[Time ~| [Hour ~ =l L_Coed |
Connect | [Pariion =l
Fault | [Text ~ =~
Step Value: [10
[Partiion'~ The numericis mapped ~ | | | [Total'~ The Total of a Database Field = Get Template.
into a series of partiions, defined = lemeee. |
loy a step value
Go To Full
= Draw Chart
~Chart Drawing Limits ~Histagrams Previzw-Mail
" No Node or Link Limits ¥ Records 2[9] Numeric
@ ShowFirst oo = v All Agg Field 308
R = | e I AlAzRIREED 5[7] All(120) Tested
4[] 11 Different
~Tille 15051
Enterthe Tile forthe Chart i
1201] =l





Here, the field, Mail, is aggregated using an aggregation type of Total.

This means that each node in the Daisy Chart will have a total of the field, Mail, for all the records that are mapped to that node.

The boring default name for the aggregation, Total1, can be easily changed, by typing in a new one.
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Here, Total Mail has been entered.

5.6 Restrictions of the Quick Chart Setup

In Quick Draw Chart only 4 mapping and aggregation fields can be entered.  The actual limits in Daisy depend on the version, but are usually at least 10 for both.

The mapping formats and aggregation types allowed in this dialog are also reduced in number, to make setting up of charts simpler.

5.7 Drawing the Chart

Once all the settings have been entered, just click OK to draw the chart.

[image: image33.png]2
Cpen

Daisy 2003 Lite [SoftwareTest
Fle View Draw Options

o
Close

el

View

Help

3

Draw

k3

Zoom

=]
Print.

%

Cancel

Stop.

IR

[&] &

Daisy

Use Daisy to draw Daisy and other charts of databases by
opening thern from & CSV file or a Microsoft Excel
worksheet

Use the menus and the toolbar, to control databases, view
data, draw Daisy Charts and control how the program looks
and acts

A database is open and a Daisy Chart has been drawn

Click on any of the nodes or boxes in the chart and you will
obtain the details in an Investigation window, which has
buttons, that will display lists of Records and Links in Daisy
Grids.

Select an area with the mouse and the chart will be zoomed
ta the new size.

You can also use the Draw or right click menus and full
investigation, zooming, panning and saving commands
can be used

Rermernber that you cant change the data in the database
with Daisy 50 be brave and experimentl

Daisy - New Browser





Note how the chart is not fully shown, as the chart window is too small.  Other parts can be viewed by using the scroll-bars.

5.8 Printing the Drawn Chart

Once the chart has been drawn, use the Print command in the Draw menu.
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You can choose the orientation and define whether a box is to be placed around the chart.

5.9 Copying the Drawn Chart
Shown opposite is the drawn Daisy Chart.

It is interesting to note how this picture was placed into this Microsoft Word document.

1. 
The chart size was first set to 1024 x 1024 pixels.  This gives a good resolution for any of the charts created by Daisy when they are copied to Word.

2. 
The chart is then redrawn using Redraw Full Size in the Draw menu.  This will draw the chart to the new chart size.

3. 
You can also use the Maximum sub-command of Zoom in the Draw menu to redraw the chart to the largest size possible.  This is always recommended as some charts can be slightly lop-sided due to more histograms on one side than the other.

4. 
The chart was then copied to the clipboard, using Copy Chart to Clipboard in the Draw menu.

It can then be pasted into any other program like Word.

This can also be used as an alternative way of printing the Daisy Chart.
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The Drawn Daisy Chart
5.10 Saving Templates
Once you have drawn a Daisy Chart, it is a good idea to save the settings as a template, so that the user can redraw the chart quickly at a later date.

Templates are saved using Save Template in the Draw menu.
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You must enter both template and file names for the template.

A comment can also be added, which describes the template.

When templates are created, they are added to the bottom of the Draw menu, with numbers for 1 to 9. Just click on the appropriate menu item to retrieve the template, for drawing, printing or modification.

Tip
Store all of your common Daisy Charts in templates.

5.11 Retrieving Templates
Templates are retrieved using Get Template in the Draw menu.
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The previously saved template has been selected.

Just click OK to load it and draw the Daisy Chart.

6. Investigating Data with Daisy
Daisy has many ways to investigate the Daisy Chart and the associated database.

These include :-

Zooming a Daisy Chart to look at parts of the chart in detail.

Viewing the records associated with one or more nodes.

Viewing the node values and details in a Daisy Grid.

Viewing the links as a Daisy Grid.

Applying selections and calculations to views and Daisy Grids.

Export of selected data.

The methods are described in detail in the following sections.

6.1 Using the Mouse on a Daisy Chart
There are three main ways to use the mouse to investigate the Daisy Chart :-

The first and most powerful is to use the mouse to zoom in to a particular area of the chart.  

This is described in detail in Section 6.2.

The mouse can also be used to select a node for investigating the records and node details at a particular node.  

This is described in Section 6.3.

The mouse can also be used in conjunction with various Menu commands to select more than one node for more complicated processing. 

It is often forgotten that the right click of the mouse is a very powerful feature in many Windows programs.  

This is no exception in Daisy.

These can be used in three main places :-

In the chart drawing window, where a subset of the menus is called.

In the Help, where the standard Internet Explorer, right click menu is shown.

In Daisy Grids, where extra commands can be accessed.

6.2 Zooming a Daisy Chart
To zoom a Daisy Chart with the mouse, select the top left corner of the area to be selected with the left mouse button and then drag the mouse, with the button still depressed to select the required area to be investigated.  

The area selected will be marked by a dotted rectangle.
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Note how the rectangle and hence the area to be redrawn, is always the same shape as the main Daisy window. 

Tip
Experiment with the mouse to see how you can select different areas.

Once the mouse button is released the Daisy Chart will be redrawn.
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This process can be repeated as many times as required until the correct area has been selected.

Use the Redraw Full Size command in the Draw menu to return the Daisy Chart to the full size image shown opposite.

Note that there are other forms of zooming.

The most useful is Zoom About, which can be used to zoom a chart about a particular point.  Just select that point, depress the mouse left button and then drag the mouse until the required area is selected.

6.3 Investigating a Node in a Daisy Chart
In the Daisy Chart shown below, the node Tuesday has been clicked, which brings up the small investigation window in the top right.

The Records button in the small window has been clicked to view the records associated with that node.  
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Note :-

The blue highlight in the Node Tuesday.

The small window and the Records Daisy Grid have been moved to make the display more readable.

You can also click the Links button to display all the links.

In this investigation, the data has been displayed in a simple grid.  The data can also be displayed using Microsoft Excel in most versions of Daisy.  See Section 9 for more details.

6.4 Point and Click Selections
Daisy has the facility to select more than one node at one time.

The main Daisy Point and Click selection is used to select all the records associated with more than one node.  Note that this important feature can also be invoked with Control-R.
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The figure shows the selection of Records on a Tuesday or Wednesday, which have an Hour of 15 or 16.  The selection rule is that nodes in the same mapping field are 'or'ed, whilst those in different ones are 'and'ed.
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To actually perform the selection, you just click anywhere else on the background of the Daisy Chart.

Note the Help in the Help window at the right.

The Daisy Grid displayed is shown below.
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This method of selection can also be used to select nodes and links.

In the example below, all of the Day of the Week nodes have been selected and are displayed in a Daisy Grid.
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The next one shows all of the links to Tue and Wed.
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All of these Daisy Grids can be sorted, printed and processed in the normal way.

6.5 Using the View Menu
The View menu contains a series of commands to view selections of records, nodes and links. 

All Records

First 20 Records

Selected Records

Records in Chart





Records Not in Chart





First At Node

All Nodes









Nodes in Chart





Not First At Node

All Nodes









Nodes in Chart





Point and Click

All Nodes

Selected Nodes

Nodes in Chart





Nodes Not In Chart





Marked





Point and Click

All Links

Selected Links

Links in Chart

Links Not in Chart

Marked

Between Nodes





Point and Click

The In Chart and Not In Chart selections are obvious, in that they select directly from everything displayed in the Daisy Chart.

Use the Not in Chart selections to find out which records, nodes and links are not shown in the drawn chart.

First At Node selects the first record at each node, whilst Not First At Node selects all the others.  

These two selections can be used together to split a database.  First At Node is used to create a set of records with one for each node and Not First At Node is used to create a set containing everything else.

Marked selects marked nodes or links connected to them.

Between Nodes is a specialised Point and Click selection.

There are also two Find commands that can be used to find specific nodes.

Between Nodes is a powerful selection for links.

Here all links between Tuesday, Wednesday and 12 to 17 are selected.  

As with all other Point and Click selections, just click anywhere to display the links.
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The links selected are shown in a grid.
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6.6 Using the Draw Menu
The Draw menu contains a large number of commands to investigate, manipulate, zoom and pan the Daisy Chart that has been drawn.

Redraw Full Size

Zoom



Zoom In





Zoom X 2





Zoom X 3





Zoom Out





Zoom X Half





Zoom X Third





Zoom Maximum


About Point




Pan

Investigate


Node





Mapping Field

Most of these commands are reasonably obvious (Redraw Full Size, Zoom X 2 etc., Pan and Hide Nodes), are duplicates (Zoom Out and Redraw Full Size) or are menu forms of the mouse-driven actions (Zoom In and Investigate Node).

6.7 Zoom Maximum in the Draw Menu
This Adjust Daisy Window form of this command has been used extensively when incorporating Daisy Charts into documents, such as this manual and the Daisy Web Site at www.daisy2000.com.

The figure shows the application of this command to the Software Test example.
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Note how the maximum possible size of Daisy Chart has been drawn.

7. Formatting the Daisy Chart
In this section a few of the many different formatting options for Daisy Charts will be shown.

These are all set from Draw Chart called from the Draw menu.
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Tip
Because Daisy cannot change any data in the original database, spend some time experimenting to get the exact Daisy Chart you want!  You will not harm the original data.

Section 7.1 shows what is changed by each of the sub-commands and the following sections illustrate the effect of some of the changes that can be made.

7.1 The Formatting Road Map
The following shows what can be changed in each of the various sub-commands of Draw Chart.

Mapping Fields

Mapping Fields, Types and Formats





Mapping Titles





Node Order





Mapping Error Handling 

Combine


Combined Field Node Order

Aggregation Fields
Aggregations





Totals, Averages





Previous Values on Nodes





Add, Subtract, Multiply Node Values

Weighting


Weighting Field and Type

Selection


Selected Records

Calculation


Links Drawn or not





Combined Mapping

HTML Charts

HTML Charts

Node Style


Full Size Nodes





Histograms

Links Limits

Drawing Limits for Links

Nodes Limits

Drawing Limits for Nodes

Layout


Legend Drawn or not





Titles





Node and Histogram Keys





Title and Key Fonts

Nodes and Links

Node Layout





Node Fonts and Orientation





Rules for Names in Node Boxes





Aliases for Names in Node Boxes

Histograms


Histograms





Node/Histogram Ratios





Histogram Annotations or not





Histogram Fill or not





Histogram Scales

Colours


Node Colours





Histogram Colours

Some of these will now be illustrated.  All are described in the Help.

7.2 Aggregation
This is the process, where values from the records in the database, that correspond to a particular node, are totalled, averaged or processed.  They are then stored along with other details of that node.

Aggregation is described in detail in Help.

Look at the Daisy Charts in the various examples, which illustrate some of the most common aggregations.

In the building of the example chart in Section 5.5, one aggregation field was created. Total Mail contains the total of the field, Mail.

Total is the most common aggregation type, with Average not far behind!

Tip
Always use histograms with aggregations.

7.3 Copy in Aggregation
Another common aggregation is Copy, which is used to create a second copy of any other aggregation field or the default ones, such as Number of Records or Number of Links.  Use this to show histograms for an aggregation field to two different scales, or to give a field like Number of Records a more meaningful name.
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In the example above, a copy of the field, Number of Records has been made in Connections.  This new aggregation field can then be plotted as a histogram.

Note that the field to be copied, is chosen using the Set button and must precede the field being entered.

7.4 Arithmetic in Aggregation
Aggregation also contains simple arithmetic aggregations or functions, which can be used to add, subtract, multiply and divide previous aggregation fields.

A simple but pointless example, where a new aggregation field, Twice Total Mail has been created by adding Total Mail to itself.
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The complete list of arithmetic aggregations is :-

Add



Adds up to three previous fields together

Add Constant

Adds a constant to a previous field

Subtract


Subtracts one previous field from another

Subtract Constant
Subtracts a constant from a previous field

Multiply


Multiplies up to three previous fields together
Multiply Constant
Multiplies a previous field by a constant

Divide


Divides one previous field by another

Divide Constant

Divides a previous field by a constant

Negate


Negates a previous field

7.5 Histograms
The following shows histograms, which are filled, lined in black and have been annotated.  
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Set these options under Histogram Format in the main Draw Chart dialog.
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In this example, all options have been unset.
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Note that both formats have their advantages. 

For instance, if you are doing a lot of test printing, you might choose unfilled histograms, as these print quicker using less ink on a colour inkjet printer.

7.6 Histogram/Node Height Ratios
Compare this figure with some of the others.

[image: image52.png]Moaph au3 o AeQ - 81ed




Note how the ratios of the nodes and the histograms have been changed with respect to the radius of the Daisy Chart.  

These are adjusted under Node Style in Draw Chart.
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Note that the default ratios in Daisy have to be very much a compromise.  Daisy Charts can often be improved by judicious changing of these ratios.

7.7 Link Formats
Two methods are provided in Nodes and Links Format of enhancing the display and printing of links in Daisy Charts.
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In the first the shades of grey used for the lowest ten percent of links are darkened, so that they show up better.

You would use this, when you are looking for faint links, at the same time as you wanted the major ones to be shown.

In the second method of enhancement, you can draw or print the top ten percent as a double-width line.

7.8 Link Limits
Take any of the example Daisy Charts and experiment with the various link limits.
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The settings show that links will not be shown unless there are at least three links between two nodes.

Use a technique like this to make a Daisy Chart much more readable.

This is especially important with printed charts, which in most cases do not have the same range of colours that are available to the display.

Note the Percent method of limiting links shown.

Setting a lower limit of say 40 here, would mean that the first 40 percent of links would not be shown.  However, if a group of links with the same value would be split by the chosen limit, then all that group would be shown.

7.9 Mapping
Mapping is the process of translating the database into the Daisy Chart.

The dialog shown is from the Software Test example.
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Note the Test (Ts) and Disable (Ds) features which have been added in Daisy 2003.
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Consider the example, where a database field, Fault, is mapped with a mapping type of Text and a similar mapping format.

For each different value of the database field, a new node will be created in the chart in the arc or group corresponding to the mapping field, Fault.

In our example, the nodes created could be Call Help, Dial, Mail, Network, Response, Carrier, Reset and Ring.  (See the Quality or Software Test Example, which is just such data.)

Each node is now a set of values in its own right. It has a node name, a node group, which in simple mappings is the field and various numeric values.  These include the number of records and links at the node and any aggregated values.  All of the numeric values can be drawn as histograms on the node.

Mapping is described in detail in the Help.

Two important points :-

Keep the mapping simple when you start.  Use Text for text, Day of Week or Month-Year for dates, Hour for times and Partition for numerics.

Be prepared to find nodes that you are not expecting, as sadly most databases are not as correct as their owners would believe!

7.10 Nodes
The first picture shows nodes with histograms and a radially printed node key. The second shows nodes without histograms.
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Change the histograms and the node style, using Node Style in Draw Chart. 

Tip
Use large nodes if you want to show as much text in the node box as possible.

7.11 Node Fonts
The following shows nodes with histograms, with the text shown in a larger font.
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Change the font using the Fonts tab in Nodes and Links in Draw Chart.
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7.12 Node Keys
The following shows nodes with histograms and a node key shown radially.
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The node key can be switched on and off using the Show Node Details Radially on Chart check box in the Layout in Node and Links in Draw Chart.
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Note that this section can also be used to set Daisy Charts that are not a full circle.  Just set the Start and Included Angles.

7.13 Node Limits
Take any of the example Daisy Charts and experiment with the various node limits.

Use the Show First limit to show only the important nodes in a chart.  Typical values of between 10 and 50 are suitable for most Daisy Charts.
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The selection shown would select the first forty nodes in each mapping field.

Alternatively, if you are looking for nodes, that shouldn't be there, invert the selection in the Daisy Chart and these will be shown.

Show nodes that are not linked to any other by setting a node limit based on links.  Use say an upper link limit of 1.

7.14 Selection
Selection allows records or nodes to be selected against a particular criteria.

A typical selection, would select records, where the database field, Status contained a value of Fail.
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Selection is described in detail in the Help.  

Always use the Quick Setup to create an initial selection.
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In the figure the field, Status, has been selected and the Selection Type is being determined.  

Note the Back and Next buttons used to navigate between screens.

7.15 Weighting
Charts are normally drawn with each record in the database counting one.

However, it is possible to draw charts, where the calculations are weighted according to a field in the database.  For example, in the Software Test example, we have drawn the Daisy Chart against the total and the average of Connect.
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8. Mapping Philosophy
How a database is to be mapped depends very heavily on the fields and their data.  How the various field types are mapped varies too, but a simple set of rules can be used as a guide.

When first mapping a database, do not be too ambitious.  Don't try and map seven or more fields, each of which can have hundreds of values!

Feel your way in, by mapping perhaps only three or four fields, choosing a mapping type and format that will create perhaps ten to twenty nodes.  Once you identify the dominant links in the database, then the mapping can be expanded to further separate the data. 

Tip 
Don't hesitate to use the conversational method of adding a mapping field.  This is called by the Add button on the Draw Chart and Mapping Fields dialogs.  

Tip
Remember too, that the test facility can be invaluable in checking the mapping you have selected.

Each of the four mapping types should be used as appropriate.  

Date

Dates e.g. 12-January-1998


Numeric
Numbers, Integers etc. e.g. 12, 12.45

Text

Anything at all!

Time

Times e.g. 12:45

Remember though, that as Daisy handles all data as text, then data can often be mapped in two ways.  For example, the string 12-January-1998 could be mapped both as a date or as text.
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8.1 Text Fields
Text fields are best mapped as simple text, unless they are a field, such as a post-code or telephone number, in which case some of the special mapping formats can be used.  

Also, mapping perhaps the first few characters, the first word or the last, will restrict the number of nodes created during the initial investigations.

Note how in the Options dialog to the right, the Jockey would be mapped by the first ten characters of the name, with the case ignored.

8.2 Date and Time Fields

Date fields are best grouped, so that you have about ten to twenty nodes.  Perhaps, map by Month, Year or Month-Year.  Mapping by Day-of-Week is often invaluable, as dates entered at the week-end often indicate incorrect data.  (It has also been known for fraudulent transactions to be added to a database outside of normal working hours!)
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Remember too, that you can fill in the missing nodes.  For instance, when mapping by Day of Week, you can create a node for each of the seven possibilities.  This makes it obvious, if you have no records for Wednesday.

See how the Sun to Sat check box has been set in Create All Nodes in the Options dialog to the right.

Follow similar rules for Time fields, where Hour is recommended.

When using Date and Time fields, they are best ordered in ascending date or time value. This will show any daily, weekly or monthly patterns.
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8.3 Numeric Fields

Again with numeric fields, it is a good idea to aim initially for a small number of fields, by using the Partition mapping, which splits the data into say, 0 to 5, 5 to 10 etc.  

In the Options dialog to the right, the field, Connect has been mapped using a step of 5.

Order the nodes as ascending numeric values.

Tip
Do not use a mapping format of Numeric unless you have very few values!

8.4 Missing, Null and Error Values
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Note too, the use of the Missing/Null Values and Error Values options in the mapping.  

These can be set using the Missing and Error tabs in the Options dialog for the mapping field.

These can be used to set a default value for fields, for which values are incorrect.  You might choose to put No Value, where all fields should have a value.  Records would then be mapped to a node called Oops.

8.5 Database Quality
Database Quality Measurement is perhaps the simplest application of Daisy.

Before trying to analyse your database, always check it's quality!

Once the initial Daisy Chart has been drawn using the rules from the previous section, then apply limits to the nodes.  Normally, with Daisy you are looking for common records and links, but with database quality, it is often more useful to look for those nodes with only a few records.

Daisy has deliberately been designed with many different mapping types.  These enable all possible checks to be applied to your database.

Aggregation in Daisy is also a powerful database checking tool. Use it to create totals, averages, maxima and minima for each node.  These may well indicate errors in the database.

Tip
Before starting any Database Project that uses existing databases, use Daisy to check that databases contain exactly what they are supposed to and that the quality of the data is what it should be!

8.6 Incident, Event and Quality Databases
Many databases that will be examined by Daisy, can loosely be described as incident, event or quality databases. 

Consider all of the guarantee returns, received for cars, televisions, computer software or any product.  These can be stored in a database, which might include fields such as date, date made, fault type, product etc.

By mapping this database, any common links in the pattern of faults can be ascertained. In the bad old days, this was often obvious, but with product quality now being of a generally high level, it is often much more difficult to spot common faults.  Especially, if they only occur a few times and then perhaps as far apart as Scunthorpe and Sydney!

The three most powerful mapping formats when analysing these databases are, Keyword, Day of Week and Hour.

Use Keyword to map individual keywords held in a text field.  Thus a field containing red battery gearbox, would be mapped to the three nodes, red, battery and gearbox.

Day of Week always creates interesting mapping and links.  It is a valuable check on data, as many dates are not valid on Saturday and Sunday. 

Hour can map the pattern of events throughout the day.

In event databases, aggregations and histograms are extremely important and should be used liberally.  These further identify the links, connections, problems and good points of your business and its database.

Returning to the Newmarket Tutorial.  Is this just a simple database of events?

8.7 Financial Databases
Daisy is ideal for the analysis of financial databases.

A typical database would be a database containing details of all cheques issued by a business.  It will contain fields, such as date issued, cheque number, amount, invoice number, payee etc.  The more fields in fact, the better and the more likely useful information can be deduced.

Daisy does not necessarily always look for fraud and other serious problems in financial databases.

A Retailing Company consists of seven chemist/pharmacy/fancy goods shops that have been brought together during the recession.  Each shop trades more or less independently, with managers being responsible for buying policies and they can sign cheques up to a certain limit.

Daisy was installed to make sure the rules were adhered to.

A chart of the cheques, showed that no-one was exceeding their signing limit, by using multiple payments and there were no cheques that appeared suspicious.

At a first glance Daisy had failed, although it had proved, it was likely that no significant fraud was taking place.

But then Daisy started to show the benefits.

For instance, it became obvious that the shops had many common suppliers, and that there was little or no effort to claim the maximum discounts available.  It was also obvious, that different managers applied different and very incompatible purchasing policies.

The direct savings from these two areas were significant. 

In addition, a large amount of administration expenses were saved by raising cheque signing limits.

This example shows the benefits that can accrue by using Daisy on the simplest of financial databases.  But not necessarily where they are to be expected!

8.8 Name, Address and Phone/FAX Databases
Look at the mapping formats for text fields in Daisy and you will notice many formats specifically geared to this type of data.

These include Last Word, Street Name and Phone Area.  Note that some of these mappings are country dependent and you must set the International information on your Computer correctly.

Never underestimate the Soundex mapping.  This technique was developed many years ago by the US Census Bureau, to try and sort out the Census returns.  Soundex maps words and phrases that sound similar to the same node.

8.9 Characteristic Database Patterns
As you investigate a database further, you start to recognise characteristic patterns associated with the data.

Consider a database of product failures, accidents, medical test results or X-rays of welds on a steel structure.

Once sufficient data has been accumulated, a characteristic pattern will often be seen, with various histogram peaks and linkages being prominent.

By drawing the same Daisy Charts every day, week or other appropriate time period, similar patterns will indicate that performance is roughly the same.  However, any new failure or fault, incorrect operation by a technician or batch of poor components will produce a distortion in the pattern.  Further investigation of the database should provide early indication of the cause of the problem.

8.10 Duplicates
One of the major problems of databases is records that of duplicate or near-duplicate records.  We all get junk mail addressed to various forms of our name!

Combine all of the mapping fields into a single value, by creating a Duplicate Chart in the Quick Chart Setup.

8.11 Proving the Negative
A Daisy Chart was drawn of failures in a large and complicated electrical network.

At first glance, there appeared to be no strong links, with the links creating a sort of grey morass in the centre of the chart.

The client was delighted, in that Daisy had proved that each of the failures were independent and were not related to any others.  This meant that the individual components could be analysed separately to improve their performance.

As in this case, the negative is often difficult to prove, but if you can, it is invaluable in getting to the bottom of a difficult problem.

8.12 Conclusion
Often, a database will be a mixture of all of these simple examples.  And others too! 

But this is the power of Daisy! 

Daisy does not believe that the data for your problem is unique.  All data is data and thus it can be analysed. 

And analysed quickly and easily to your benefit!

9. Daisy and Microsoft Excel
All versions of Daisy have a powerful link to Microsoft Excel, that enables Excel workbooks and the worksheets they contain, to be read and written.  

Note that this link can only be used, if you have a version of Microsoft Excel later than 5.0 on your computer.  Usually this means the version of Excel that is included in Office 97 or Office 2000.

9.1 The Layout of a Worksheet
Look at the Microsoft Excel worksheet shown in the figure.
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This is the data used in the Daisy Software Test example, supplied with the program.  Note that it is supplied in this form with Excel-capable versions of Daisy in the file, Daisy2003.xls.  (Choose the Software Test worksheet!)

This is a typical way in which Daisy data is stored in Excel.  Note how the date and time of creation, the original file and other information is placed in rows 3 to 7 of the worksheet, with the field names in row 9 and the data starting in 11.

Note the worksheet name, All Records.

What is stored and the default positions of the field names and the data can be defined using Excel in the Options menu.
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9.2 Importing Worksheets into Daisy
To import a worksheet into Daisy, a similar procedure to any other database is followed.

After choosing Excel from the Open Database item in the File menu, the following dialog will be displayed.
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The Excel workbook, Daisy2003.xls that is supplied with Daisy has been selected.

9.3 Using Microsoft Excel for Grids
The standard Daisy Grids can also be displayed using Excel.  

There are a lot of advantages in this technique and it can be recommended for many applications of Daisy.

Daisy has a limit to the number of grids and this can be a nuisance with large and complicated analyses.  Excel has a much higher limit.

Excel is completely independent of Daisy and thus can be used to save the exported data in appropriate workbooks as it is created.  Data can also be easily cut and pasted from worksheet to worksheet to accumulate data how it is required.

Excel can of course be used to further process, display and print the data.  Note that Daisy always exports the data, so that it can be printed immediately without any further formatting from Excel.

But the major advantage is often one of knowledge.  You have probably used Excel for some years and know exactly how to perform a calculation or draw a graph.  Once you obtain the data!  And that's what Daisy is for!

However, as Excel is accessed through OLE Automation, it can be a lot slower than the standard Daisy Grids.

9.4 Enabling Microsoft Excel for Grids
Just click the Excel icon in the toolbar to change from standard Daisy Grids to Microsoft Excel and vice-versa.
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Note that as the icon has been depressed, it indicates that Microsoft Excel will be used for Daisy Grids.

This setting can also be changed from the Use Microsoft Excel for Grids command in the View menu.

9.5 Example Grids in Microsoft Excel
All Daisy Grids are copied to a workbook called Object in Microsoft Excel.  Options can be setup, so that this will be automatically saved on exit from Daisy.

The figure shows three worksheets, which hold data for Monday, Tuesday and Wednesday, saved in a workbook.
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Note that Daisy will not overwrite any data in the Excel workbook.  It will however create new worksheets as required.

Compare this data with that shown in Section 9.1 and notice that the names are shown in the first row, with no header information.  The format is setup under Excel in the Options menu.

10. Daisy and Web Site Log Files
All versions of Daisy can now read the Log Files created by an Internet Web Site directly.  

Two example files, WebLogCommon.txt and WebLogExtended.txt, are placed in the Examples sub-directory, when Daisy is installed.  Both follow the rules for these files, as laid down by the various standards for the World Wide Web.

The first few records of data from WebLogCommon.txt are shown below.
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#7| 04/Jul/1993 04:0451 +0100 GET /images/offer.gif HTTP/1.1 GET fimages/offer.git offer.gif Graphic
#8|  04/Jul/1999 04:0452 +0100 GET /images/signup.gif HTTP/1.1 GET fimages/signup.gif signup.gif Graphic
#9|  04/Jul/1999 06:53:45. +0100 GET /faxemail html HTTP/1.0 GET Maxemail html faxemail html HTML
#10| 04/Jul/1999 11:30:13. +0100 HEAD / HTTP/1.1 HEAD
#11|  04/Jul/1999 12:07:39. +0100 GET /HTTP/1.0 GET # # HTML
#12| 04/Jul/1999 12:07:40. +0100 GET /nav.html HTTP/1.0 GET Inaw html nav.html HTML
#13|  04/Jul/1999 12:07:40. +0100 GET fhome2 html HTTP/1.0 GET /home2 html home2.htm| HTML
#14|  047Jul/1595 12:07:41 +0100 GET /images/nav_bgd.aif HTTP/1.0  GET fimages/nav_bod.gift  nav_bgd.git Graphic
#15|  04/Jul/1595 12:07:41 +0100 GET /images/home_fitleb.git HTTP/1.0 GET Jfimages/home_titleB.gif home_tile6.gift  Graphic
#16|  04/Jul/1595 12:07.42. +0100 GET /images/dummy.gif HTTP/1.0 GET fimages/durmmy.gif durmnrmy.gif Graphic
#17|  047Jul/1595 12:07.42. +0100 GET /images/offer.gif HTTP/1.0 GET fimages/offer.git offer.gif Graphic
#18|  04/Jul/1595 12:07:49. +0100 GET /images/signup.gif HTTP/1.0 GET Jfimages/signup.git signup.gif Graphic -
<] W oy





Note that various names in this file have been changed to meaningless garbage, so that the originating Web Site cannot be identified.  The field, RemoteHost has also been encoded as H-1, H-2 etc.

The file is in the Web Site Common Format with two extra fields, Referer and Browser.  

This is produced by many Web Sites around the world.  A complete discussion of the format of these files is beyond the scope of this Manual, and the reader is referred to any of the excellent books or Web Sites, (such as www.w3.org) on the subject.

10.1 Reading a Web Site Log File
Note that before reading a Web Site Log File, you may need to do a small amount of checking, especially if your Web Server is Unix-based.  

The file will need to be given a name such as WebSiteLog.txt or WebSiteLog.log, so that Daisy can locate it correctly.

It is also not a bad idea to read the file with something like WordPad, to see if the file can be correctly read under Windows.

Don't worry about the fact that the file is only delimited by newline characters, rather than carriage return/line feed.  This is the Unix standard, which Daisy can read directly.

Daisy can also accept files delimited by the tab character, rather then the more usual space.

Why is it that the various operating systems can't have the same rules about files?

When a Web Site Log File is opened, the familiar file opening dialog is shown, but with quite a few extra check boxes and options, which determine how the file will be decoded.
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In the first extra frame, the Log File Format can be set.

Daisy can read three main formats :-

The Common Format, which contains just seven fields; Remote Host, rfc931, AuthUser, Date, Request, Status and Bytes.

The Augmented Format, which is the same as Common, but with two extra fields; Referer and Browser.

The Extended Format, in which the fields are defined by a #fields directive.

Check the appropriate box if your file is delimited by tabs rather than spaces.

Tip
Note that if you want to be lazy and don’t know the format of your Web Site Log File, just click Test Format and Daisy will sort out the format for you!

In the second frame the various check boxes and values set how the Web Site Log File will be expanded on reading. 

See the next sections for full details.

The Encode ‘RemoteHost’ as Hnnn box should be checked to make the RemoteHost anonymous for security and confidentiality.

As with all Daisy file opening, just click OK to load the data into the program.

Note that because Web Site Log Files need to be decoded, Daisy reads the file first and holds all input and calculated values in the memory.

10.2 Expanding the Web Site Log File

Daisy has the facility to expand the Web Site Log File and add extra fields to the database.

Three fields can be expanded and split into other fields as follows :-

Date


Date.Date


Date 



Date.Time


Time 



Date.GMT 


GMT - e.g. +0100

Request

Request.Req

Request - e.g. GET, HEAD




Request.Path

Path of File - e.g. /work/home.html



Request.File


Name of File 



Request.Type

Type of File - e.g. HTML, Graphic




Request.HTTP

HTTP 
Browser

Browser.Type

Type - e.g. Mozilla




Browser.OS


OS - e.g. Win95, WinNT




Browser.Name

Name - e.g. IE3, IE4, Netscape
This is to make the drawing of Daisy Charts much easier.  All can be used as if they are permanently in the database.

Note that these fields are not physically added to the Web Site Log File, but are stored in the computer’s memory or in a temporary file on the hard disc.

To invoke any of the splitting, just check the various boxes, Split ‘Date’, Split ‘Request’ and/or Split ‘Browser’.  These boxes are checked in the opening dialog shown opposite. 

It is likely that as Daisy develops in this area, that more fields will be split and more sub-fields will be added.

10.3 Sessions and Previous Pages

Daisy also has the ability to handle sessions in the Web Site Log File.  When this feature is invoked, previous pages and the sequence of pages are also added to the file.

A session is defined as a group of records in the Web Site Log File with the same RemoteHost, that follow each other without timeout.

The timeout, which by default is 300 seconds, is set in the opening dialog for Web Site Log Files.

Note that the Add Previous Page/Sequence/Session Information has been checked.

This adds the following fields to the Web Site Log File.

Previous

Previous.Path

Path - e.g. /work/home.html




Previous.File

File 
Sequence

Sequence.Path

Path - e.g. nav, home, home2




Sequence.Length

Length 
Session

Session.Number

Number 
Session.FirstLast

First and Last Flag - e.g. First, Last




Session.HTML

HTML Page in Session




Session.Graphic

Graphic File in Session




Session.Request

Request in Session




Session.Bytes

Running Bytes Total




Session.Errors

Running Error Total




Session.Secs

Elapsed Time 

Note that the Session Timeout is set to 300 seconds and the maximum length of a Page Sequence has been set to 4.

10.4 A Few Techniques and Tricks

The internal layout of the Web Site Log File has been designed so that it is easy to draw Daisy Charts and to select records.

The expanded fields such as Date.Date and Request.Type are very useful in both mapping and selection. 

Use the Daisy Day of Week selection with Date.Date to perhaps select data from a Wednesday.

Use Request.File to analyse which are the most popular files.

Use Request.Type to apportion data between HTML and Graphic files.

Use Session.FirstLast in selections to draw Session Daisy Charts.

10.5 Example Daisy Charts

Shown below is one of the example Daisy Charts that can be drawn using a supplied template and a typical  Web Site Log File.  

This chart effectively shows the overall performance of a Web Site for a particular week.
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Note :-

How this is a basic Daisy Date/Time analysis, with the first two mappings showing Day of the Week and How of the Day.

The green histograms show the Number of Downloads, whilst the mauve show the Number of Bytes.

The files are shown in decreasing order of bytes.

Even a Daisy Chart as simple as this can show several important features and suggest questions about the usage of a Web Site.

Look at the patterns on the Day of the Week and Hour of the Day.  Do these fit with what you expect?  It would appear that this is very much a business-orientated Web Site, as there is little traffic at the weekend and outside of 9 to 5.

Is the pattern of files downloaded what you would expect?  

As the first file is a graphic one, so could you improve the performance of the Web Site, by compressing or simplifying this file?

Is the ratio of Bytes Downloaded in graphics to that in HTML files acceptable?  With this Web Site the ratio is almost one-to-one, which suggests that the graphics have been compressed.

As most files seem to result in a successful download with a status of 200, it would appear that the users are generally not having too many failures.

Note that this Daisy Chart or something similar to it, should be drawn each week, so that the progress and use of the Web Site can be properly monitored.

The second Daisy Chart shows a Session analysis of the Web Site Log File.

[image: image73.png]



Again this was produced using a supplied template and a typical Web Site Log File.

Note how this Daisy Chart shows the Number of Pages visited and the Connect Time for each user.

11. Daisy and Microsoft ADO

ADO is Microsoft’s one size fits all method of accessing databases.

Daisy 2003 can use ADO to connect to any database that has a suitable driver.  Less powerful versions of Daisy can’t use ADO.

11.1 Enabling ADO

ADO must be installed on your computer and you must make sure that ADO has been enabled in Daisy.

All recent versions of Windows after 2000 are installed with a working version of ADO.  It is recommended that you check that you have one with a version number of after 2.1, as this is needed for Daisy.

If ADO does not appear in the File menu, then this may be because ADO has been disabled in Daisy.  Check using Options in the Options menu.
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Make sure that All Microsoft ADO Connections is checked in Databases.

11.2 An Example
To use ADO, two pieces of information must be entered; a connection string and an SQL record source.

These are best illustrated with an example.
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Here, the Microsoft Access database, Daisy2003.mdb, which is supplied with Daisy is being opened using ADO.

Note that if you are familiar with Data Link Files or ODBC Data Source Names, then these can be used instead of the Connection String.  However, the latter is recommended, as it seems to be the preferred method of most of our users.

11.3 Creating an ADO Connection String

This may appear to be daunting, but it seems to be one of those processes that either works quickly first time or needs a lot of help from those who know databases and networks in depth.

Start by using the Create button beside Use Connection String, which brings up the dialog shown.
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Note that the Microsoft Jet 4.0 OLE DB Provider has been chosen as this is the easiest way to connect to Microsoft Access databases.

After clicking Next you will be asked to choose the database.
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Daisy2003.mdb has been chosen.

Note Test Connection.

If it works successfully, then you have a valid ADO Connection and after clicking OK you will return to the Open ADO dialog.
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Note the Test Connection in this dialog, which gives more information.
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There is also an Edit button, which can be used to modify the ADO Connection String.

11.4 Build a Record Source

The Record Source can either be entered directly or created using the Build button at the side of Enter the Record Source.

The dialog called by Build is shown.
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The SoftwareTest table in Daisy2003.mdb has been chosen. 

Click OK to accept the table.

On returning to the Open ADO dialog, the SQL will now be shown.
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11.5 Opening the Database

Just click OK and the database will be loaded into Daisy.

Note that after the data has been loaded into Daisy, the connection is closed unless Work Directly on Data is checked.

12. The Daisy Profile
Daisy 2003 has a very powerful profile feature that should be used for all but the simplest analyses.  Profiles are not available in Daisy Lite and Daisy Lite Plus.

Consider that as your methods get more advanced, you will start to use other files, objects and techniques with the database.

The two most important of these are :-

Templates
Hold details of Daisy Charts, so they can be drawn quickly and to predetermined formats.

Start-up
You may want to setup Daisy in a particular way, when it starts.

All of these and the general program settings can be saved with the database details as a Daisy Project.  The profile file always has a .dyp extension.

Note that if you are doing anything complicated with Daisy, always use a profile, as it ties everything to a meaningful name for the job.  It also helps untrained staff display and print sophisticated Daisy Charts, which must be produced on a regular basis.

By default, on exit from a profile, everything is saved.

All settings, Help editor settings and the history of database access are stored when Daisy is closed. 
12.1 DaisyLite - The Default Profile
The default profile is called DaisyLite as this is the one used by Daisy Lite and Daisy Lite Plus.

If you don’t create any others, then this profile is always used by Daisy 2003.

12.2 The Profile Menu
Profiles are handled using a Profiles sub-menu of the File menu.
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Each of the commands in the menu will be described in the following sections.

12.3 Creating a Profile

Profiles are created using the Save As command in the Profiles sub-menu.
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Here a profile called Software Test is being created for use with the Software Test example.

There is a limit of 100 to the number of profiles that can be created.

12.4 Opening a Profile

A profile is opened using the Open command in the Profiles sub-menu.
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The Software Test profile is being opened.

After it has opened, the caption of Daisy changes with the addition of the profile name.
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12.5 Editing Profiles

Two commands, Edit and Clear, can be used to change profiles.

The most important is the StartUp sub-command of Edit, which is used to set how the profile starts.
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Here the Software Test example has been selected as a CSV Database and four templates have been added.  All will be shown in the Draw menu, when the profile is opened.

The Options sub-command of Edit can be used to set other parameters.
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Note how this profile has been setup so that it will be added to the File menu.

12.6 Profile Properties

The properties of the profile can be displayed using the Properties command in the Profile sub-menu.
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This is a very powerful troubleshooting tool for Daisy.

12.7 Import and Export of Profiles

Profiles can be imported and exported to disc, so that they can be passed between computers and users.

12.8 Adding Profiles to the File Menu

Profiles can be added to the File menu, so that they can be opened quickly and easily.
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Software Test would be clicked to open the profile.

13. HTML Charts

HTML Charts are just Internet-friendly versions of Daisy and other charts.

13.1 An Example of an HTML Chart

One of the examples distributed with Daisy is an HTML Chart version of Software Test.

It is run in the normal way from Open Examples in the File menu.
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This example will also create and open an HTML Chart at the same time as it creates the Daisy Chart.

It was used to create the chart shown on the following pages.

13.2 The HTML Chart

Shown is an HTML Chart version of the Software Test example, displayed in Internet Explorer 4.  (There may not be many copies of IE 4 still installed, but we still make Daisy work with old friends!)
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Note the mini-index of hyperlinks at the top of the display.  

They show an index to the HTML Chart and all the records, nodes and links.

But you can also click on the nodes themselves to view the underlying structure.
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These grids can be sorted by clicking on the heading of the appropriate column. 
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The grid has been sorted on Connect.

You can also display the links at the node.
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Note :-

All the hyperlinks which enable you to look at all of the records, links and nodes.

The columns that can be sorted by clicking the headings.

The totals in each grid.

But above all everything is pure HTML and can be run on any Internet or Intranet server.

It is the ideal way to distribute charts, Daisy or otherwise, to management, colleagues and customers.

13.3 The Structure of an HTML Chart

An HTML Chart is a series of HTML pages and a Chart Image file.

Note the file names in the figures, which show the HTML Chart.  All have a name, which starts with SoftwareTest.

13.4 The Chart Image file

The Chart Image file is a copy of the image created with the drawn Daisy Chart.

In this case it is an 800 x 800 pixel graphic, which has been saved as SoftwareTest.gif.  The file name was entered when the HTML Chart was originally defined.
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It is an industry-standard gif file, but created without using any of the patented compression methods, that require a special licence.

Note that all of the other file names in the HTML Chart are based on the name of the Chart Image file.

13.5 The Main Page of the HTML Chart

The main page of the HTML Chart is the file that is opened in Internet Explorer to actually display the chart.  It is a container for the Chart Image file and all the other files of the HTML Chart.

It is SoftwareTest.html in the example shown at the start of this Section.

The main page and the Chart Image file have the same file name with different extensions of .html and .gif respectively.

Note that you can replace the main page with one created using a full HTML Editor, such as Microsoft Front Page.  The only criteria that must be followed, is that the map used to trace clicking of the image in the page must be copied from the created to the new page.

13.6 The Index Page of the HTML Chart

The index page is an index to all of the pages in the HTML Chart.
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This shows the index page of the example.

Note the name of SoftwareTestIndex.html.

Again as with the main page, the index can be replaced with a user-created page.

The Master Index is a list of all HTML Charts created in the HTML Chart directory on your computer and it can be updated every time, that a new HTML Chart is created.

13.7 The Related Pages of the HTML Chart

These are all of the other pages in the HTML Chart.

Again in our example, they all start with SoftwareTest and are followed by extra characters that define the page.

Typical names are :-

SoftwareTest_AllRecords.html - All records
SoftwareTest_AllLinks.html - All links 

SoftwareTest_AllNodes.html - All nodes 

SoftwareTest_N_1_1.html  - One of the files associated with a node

When a page is sorted by clicking on the header of a column, other pages are shown, which have extra characters at the end of the name.

All the related pages have extensions of .html.

13.8 The Size of an HTML Chart

This HTML Chart actually comprises 148 files and takes up nearly 3.5 Mb of disc space.  

This sounds a lot, but is a miniscule fraction of the average hard drive!

13.9 Converting a Chart to an HTML Chart

To show that the techniques work with any chart created by Daisy, the example shown here is based on the Software Test – Boxed Histogram example.

This chart is first drawn in the normal way, after selecting it from the list of examples in Open Example in the File menu.
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Note that the chart size has been set to 640 x 640 pixels as HTML Charts generally draw better if they are square.  

Choose a chart size that suits your Web Site rules.

The Notes have also been removed from the chart to make it clean.

The HTML Chart is created using Save Chart in the Draw menu.
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Check Create an HTML Chart and the dialog opens up, so that any extra parameters can be entered.
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Note that the name of the Chart Image file has now been set.

The dialog might look formidable, but this is because there are so many things that could be set to format an HTML Chart.

All that needs to be done in a first attempt at an HTML Chart is to enter a title.

Check the Title/Format tab and then enter it.
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Software Test – Boxed Hist has been entered as a title.

Now just click OK to create the HTML Chart.
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This has been shown in Internet Explorer XP.

Click the nodes for details on the records linked to them.

13.10 HTML Charts and Templates

Note that all of the settings for HTML Charts are stored when a template is saved.

Note that you can also save the template from within the Save Chart dialog.  Just click the Save Template tab.

13.11 A Fully Worked HTML Chart Example

One of the examples distributed with Daisy is an HTML Chart version of Software Test.

It is run in the normal way from Open Examples in the File menu.
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This example will also create and open an HTML Chart at the same time as it creates the Daisy Chart.

In fact it was used to create the chart shown earlier in this Section.

Note that a chart size of 800 x 800 pixels should be used to create the HTML Chart as it was delivered with Daisy and shown on the Daisy Web Site.

Note too, that Edit the Template before Drawing Chart in the Open Examples dialog has been checked which brings up the Draw Chart dialog, when the example is opened.

13.12 Changing the Settings of the HTML Chart

Part of the Draw Chart dialog is shown.
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Note the HTML Chart section, where the check box indicates that an HTML Chart will be created when the chart is drawn.  

The Setup button in Draw Chart is used to change how the HTML Chart is created.
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Examine each of the tabs in the dialog to see how the various features of the HTML Chart can be specified.
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Main Page is used to create and format the main page of the HTML Chart.

In this example, it is SoftwareTest.html, as the Chart Image file is SoftwareTest.gif. 

Note Edit the Main HTML Page, which can be used to customise the main page.
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Note that the HTML Editor is part of Daisy and has been designed to be quick and easy to use.

Related Pages is used to setup which pages are created with the main page.
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Check the appropriate boxes, to setup the various pages.

Be careful about checking Create an All Records HTML Page unless you are sure that you have a small number of records or a suitable limit set for maximum number of records in an HTML page.

Note you can also create and edit the index page.


Title/Format is used to set the title and format the pages.
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Note the two buttons, which are used to format the title and fonts, and the various parts of the pages respectively.

The Title and Fonts dialog is shown.
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Most of this should be fairly self-explanatory, but as in all cases with Daisy, you will not do any damage by experimenting!

The HTML Page Format dialog is shown.
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Again most should be reasonably understandable and experimentation is the best policy.

The formatting of individual columns is discussed later in Section 13.13.

Note that both of these dialogs have a Reset All to Default buttons, which does just that!

Web Browser sets how the HTML Chart is opened in a Browser such as Internet Explorer after it has been created.

[image: image110.png]Main Page | Pelated Pages | Title/Format
\Weh Browser | Zip File | Upload Files
Setup the Wel Browser and the Chart Directary Index.
‘Web Browser and Chart Directary Index

When the HTML Pages have been created, they can be opened in
your default Browser.

[¥ Open Created HTML Chartin Web Browser

An Indlex can also be created to all ofthe HTML Charts inthe HTML
Chart Directory.

[V Create/Update an Index for HTML Chart Directory




The boxes are checked as required.


Zip File sets if a zip file is created of the Chart Image file, the main, index and any related pages.
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Note that if required you can only zip new files and that extra files can be added as required.

The zip file is a very simple way of distributing an HTML Chart to another user by E-Mail.

The readme file could be added to the zip file as an extra file.

Upload Files is used to upload files to an FTP site, such as a Web Site on the Internet or an organisation’s Intranet.
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Note Only Upload New Files which is used to limit the amount of FTP traffic, by not transferring files that are the same as the last one created.


Don’t forget to save the changes in a template!

13.13 Column Formats in HTML Charts

Each of the columns in the tables of HTML Charts can be formatted individually or they can take the defaults defined under HTML Page Format called from Title/Format.
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The defaults set here include ignoring blank columns, showing zeroes as blank rather than a numeric and right justifying dates, times and numerics.  Columns are not sorted and a total is only added to a numeric column.

Individual columns are formatted using Format, Sort, Hide Fields/Columns.
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Select the column to format from the list at the left and then adjust all the individual values.  If the column is not shown, then use Add Field/Column.

Check Field/Column is Hidden if the column is not to be shown in the grid or table.

13.14 Distributing HTML Charts

The easiest way to distribute an HTML Chart is to create a zip file and then use E-Mail.

14. The Daisy Golden Rules

These simple rules may or may not be invaluable, but stick to them if you can.  At least to start with!

Make sure your access to the database is fast and you are the only person, who is accessing the data when you use Daisy.

Keep the analysis simple.

If the database contains a date or a time field, then map these by Day of the Week or Hour of the Day respectively.

Never map a numeric field so that you create one node for every value.  Unless of course you are sure there are only a few values, in which case it is a good test for errors.

Don’t be afraid to use Daisy in conjunction with Microsoft Excel.

Use a colour printer.

Don’t forget to check the Daisy Web Site at www.daisy2000.com or www.daisy.co.uk.

But above all experiment and be inventive.

Appendices

Although there is no longer a Reference in the Daisy Manual it has been decided to add a list of all the mapping formats and aggregation types as two Appendices.

Appendix A - Mapping Formats

The Mapping Format is applied to each field value to change the data into the form required for mapping.

Consider as an example the Month-Year format, which acts on dates.  This would transform November 12, 2001 to Nov-2001.

Daisy contains many different formats, for mapping text, dates, times and numerics.  Special forms allow the mapping of phone numbers, post codes and E-Mail addresses.

Note that the list of available mapping formats will be expanded as the applications of Daisy increase. See the Help for the latest details.

In all commands, they are set in essentially the same way, normally using the Mapping Field, Add dialog. Alternatively, they can be edited, reviewed and deleted using the Mapping Field command in the Draw Chart dialog.

Mapping Formats, Date
The Mapping Formats for Date follow.

Break - Date
The field is mapped into a series of nodes defined by up to four breakpoints.


Breakpoints of 31-Dec-2001 and 31-Dec-2002 would yield three nodes. Note that breakpoints are always included in the lower valued node.

Date
The field is mapped directly.

Day
The day as a numeric.

Day of Week
The day of the week as text.

Tip
Use to determine if there is a weekly pattern to the data.


Day of Year


The day of the year as a numeric.  Jan 16 would be 16.

Long Date
Uses a Long Date, as defined in the International section of the Windows Control Panel.

Medium Date
As for a Short Date, except spell the month.

Month
The month as a numeric.

Month Name

The month as text.

Month-Year
The month and year are extracted and formatted as Nov 2001.

Previous Monday
Uses the date of the previous Monday.

Previous Sunday
Uses the date of the previous Sunday.

Qtr-Year
The quarter and year are extracted and formatted as Q4 2001.

Short Date
Uses a Short Date, as defined in the International section of the Windows Control Panel.

Year
The year as a numeric.

Year-Month
The year and month are extracted and formatted as 2001 Nov.

Year-Qtr
The year and quarter are extracted and formatted as 2001 Q4.

Note that the format Month-Year allows ordering of nodes by months or years. This enables charts displaying budgets and financial forecasts to make month-by-month or year-by-year comparisons. 

Qtr-Year allows a similar option with quarters and years.

Mapping Formats, Numeric
The Mapping Formats for Numeric follow.

All Numeric
All numeric characters are extracted and mapped.

Billions
Uses the billions alone.

Break - Numeric
The data is mapped into a series of nodes defined by up to four breakpoints.

Breakpoints of 0, 10 and 20 would yield four nodes.  Note that breakpoints are always included in the lower valued node.

Currency
Uses the Currency form of the data. This includes thousand separator and two decimal places.

Extract Numbers
Extracts all possible numbers from the field and maps each separately.

Use this mapping format to check that text fields do not contain integers such as 99, when company policy says they should be entered as 1999.

First Digit
Extracts and maps the first digit of the numeric.

Fixed
Uses at least one digit to the left and two digits to the right of the decimal separator.

Fraction
Extracts and maps the fractional part of the numeric.

Hundreds
Uses the hundreds. 1234 becomes 1200.

Integer
Extracts and maps the integer part of the numeric.

Last Digit
Extracts and maps the last digit of the numeric.

Last Two Digits
Extracts and maps the last two digits.

Lead Numeric
The leading numeric characters are extracted and mapped.

Millions
Uses the Millions alone.

Numeric
The Numeric is mapped directly.

Tip
Don't use this mapping unless you are sure you only have a few Numeric values.

Odd/Even
Sets Odd if odd and Even if even.

Partition
The Numeric is mapped into a series of partitions or bands.

Bands are defined by a step value.  2000 would give partitions of 0 to 2000, 2000 to 4000 etc.

Pos/Zero/Neg
Sets Pos if positive, Zero if zero and Neg if negative.

Record Number
The record number is mapped.

Use this mapping to create Circular Charts, where all of the nodes are in order of the record number of the database.

Scientific
Uses standard scientific notation.

Sign
Sets Plus if positive and Minus if negative.

Standard
Uses thousand separator and two decimal places.

String Length
Uses the length of the field value.

Tens
Uses the tens alone.

Thousands
Uses the thousands alone.

Trail Numeric
The trailing numeric characters are extracted and mapped.

Note that with Numeric mapping, an option enables rounding or truncation of the data to be performed before mapping.

Tip
Partition is the recommended way of mapping numeric data with a large number of values.  Set the step value under options.

Consider mapping the age of staff in a Personnel Database.  A step value of 10 is very suitable, and to map staff from 15 to 25, 25 to 35 etc., balance the partitions about zero.

Mapping Formats, Test

This collection of Mapping Formats which perform various tests on field values is new in Daisy 2003.

They always return True or False depending on the result of the test.

Tests for Dates follow.

Test Date After
Tests if the field is after an entered date.

Test Date Before
Tests if the field is before an entered date.

Test Date Between
Tests if the field is between two dates.

Test Date Equals
Tests if the field is equal to an entered date.

Test Date Inside
Tests if the field is inside two dates.

Test Date Outside
Tests if the field is outside two dates.

Test Date Valid

Tests if the field is a valid date.

Tests for Numerics follow.

Test Between
Tests if the field is between two entered numerics.

Test Equals 

Tests if the field is equal to an entered numeric.
Test Greater Equals 

Tests if the field is greater than or equal to an entered numeric.
Test Greater Than 

Tests if the field is greater than an entered numeric.
Test Inside 
Tests if the field is inside two entered numerics.
Test Inside Mean/SD 
Tests if the field is inside the mean and an entered number of standard deviations.
Test Less Equals

Tests if the field is less than or equal to an entered numeric.
Test Less Than 

Tests if the field is less than an entered numeric.
Test Negative 

Tests if the field is negative.
Test Non-Zero 

Tests if the field is non-zero.
Test Numeric Valid 

Tests if the field is a valid numeric.
Test Outside 
Tests if the field is outside two entered numerics.
Test Outside Mean/SD 
Tests if the field is outside the mean and an entered number of standard deviations.
Test Positive 

Tests if the field is positive.
Test Zero

Tests if the field is zero.

Tests for Text follow.

Test All Alpha

Tests if the field is all alpha characters.

Test All Numeric 
Tests if the field is all numeric characters.

Test Alpha-Numeric 
Tests if the field is all alpha-numeric characters.

Test Contains
Tests if the field contains an entered string.

Test Contains All Char 
Tests if the field contains all the entered characters.

Test Contains All Strings 



Tests if the field contains all the entered strings.

Test Contains All Words 



Tests if the field contains all the entered words.

Test Contains Any Char 



Tests if the field contains any of the entered characters.

Test Contains Any Strings 



Tests if the field contains any of the entered strings.

Test Contains Any Words 



Tests if the field contains any of the entered words.

Test EMail Valid 
Tests if the field is a valid E-Mail address.

Test Ends

Tests if the field ends in an entered string.

Test Length
Tests if the field is longer than an entered length.

Test Matches
Tests if the field matches an entered string.

Test Present
Tests if the field is present.

Test Sounds Like
Tests if the field sounds the same as an entered string.

Test Starts
Tests if the field starts with an entered string.

Test True False
Tests if the field is True or False.

Tests for Times follow.

Test Time After
Tests if the field is after an entered time.

Test Time Before
Tests if the field is before an entered time.

Test Time Between
Tests if the field is between two times.

Test Time Equals
Tests if the field is equal to an entered time.

Test Time Inside
Tests if the field is inside two times.

Test Time Outside
Tests if the field is outside two times.

Test Time Valid

Tests if the field is a valid time.

Mapping Formats, Text
The Mapping Formats for Text follow.

Absent/Present
Sets Absent if the data is absent and Present if present.

After Chars
All characters after an entered string are mapped.

All
All values are mapped to a node called All.

Use this to create a summary node for all the data in the database.

All Alpha

All alpha characters are extracted and mapped.

Before Chars
All characters before an entered string are mapped.

Between Chars
All characters between two entered strings are mapped.

EMail Account
Uses the account part of the E-Mail address.

EMail Address
The E-Mail address.

EMail Description 
Uses the description part of the E-Mail address.

EMail Domain
Uses the domain part of the E-Mail address.

Field Absent
Sets Field Name if absent.

Field Present
Sets Field Name if present.

File Directory
Extracts File Directory from field containing file path.

File Extension
Extracts File Extension from field containing file path.

File Name
Extracts File Name from field containing file path.

File Name Only
Extracts File Name without extension from field containing file path.

First Character
Uses the first character of the field.

First Name
Strips Mr., Mrs. etc. and then uses first word.

First Word
Uses the first word of the field.

Initials
Uses the initial letters of the field.

IP Address
Formats and simplifies an IP address.

Key Character
Each character of the field, except for a space, is treated as a separate keyword and all are mapped separately.

Keyword
Each word of the field is treated as a separate keyword and all are mapped separately.

Last Character
Uses the last character of the field.

Last Word
Uses the last word of the field.

Lead Alpha
The leading alpha characters are extracted and mapped.

List
Checks each field against a list.  The list can either be entered directly or extracted from the first few nodes in the mapping field.

Use this to create a mapping of the most important values, with all the others in a node called say, 'Other'. 

Phone Area
In the UK this would be say 0151 for Liverpool and in the US it would be 617 for Boston.

Phone Country
The International Code for the country.

Phone Exchange
The exchange code.

Phone Number
The full phone number.

Postcode Area
In the UK, this is the leading alpha characters of the code.

Short Postcode
In the UK, this is the first part of the code and the first numeric of the second part.

Soundex
Uses the four-character Soundex value of the field.

Use this to map all fields that sound the same or similar together.

Street Name
Uses the street name.

Street Number
Uses the street number.

Stripped Name
Uses the name with Mr., Mrs., etc. removed.

Text
The text is mapped directly.

Trail Alpha
The trailing alpha characters are extracted and mapped.

Veh Reg Letter
The UK Vehicle Registration Letter.

Veh Reg Year
The actual year of the UK Vehicle Registration.

Mapping Formats, Time
The Mapping Formats for Time follows.

AM/PM
Sets AM for AM and PM for PM

Break – Time
The Time is mapped into a series of nodes defined by up to four breakpoints.

Breakpoints of 10:00 and 18:00 would yield three nodes.  Note that breakpoints are always included in the lower valued node.

Half Hour
Uses the previous half-hour.  14:18 becomes 14:00.

Hour
The hour as a numeric
Tip
Use to determine if there is an hourly pattern to the data

Long Time
Uses a Long Time, as defined in the International section of the Windows Control Panel.

Medium Time
Uses a 12-hour format with an AM/PM designator.

Minute
The minute as a numeric.

Quarter Hour
Uses the previous quarter-hour.  14:18 becomes 14:15.

Second
The second as a numeric.

Shifts
This is similar to Break - Time, except that the first and last nodes are combined to create a shift pattern.

Short Time
Uses the 24-hour format (e.g. 15:23).

Time
The time is mapped directly

Appendix B - Aggregation Types

Daisy has many aggregation types, which are used to perform calculations in Daisy Charts.

Note that this list will be expanded as the applications of Daisy increase.  

See the Help for the latest details and for information on which aggregation types are available in your copy of Daisy.

Add
Sums up to three previous aggregation fields.

Add Constant
Adds a constant to a previous aggregation field.

Tip
Use Add, Subtract, Multiply and Divide to calculate new aggregation fields, based on previous ones.

All Equal
Yes/No if all field values are the same/different.

Tip
See how All Equal is used in the File Tutorial to show if all files with the same name are equal.

Average
Average of the field.

Average Add
Average of up to three non-consecutive fields.

Average From-To
Average of the consecutive fields defined by from and to fields.

Average Multiply
Average of up to three separate fields multiplied together in the database.  If only one field is defined, this is equivalent to Average.

Average Negative
Average of the negative values of a single field.

Average Positive
Average of the positive values of a single field.
Average Time
Average time of a single field.
Average Unsigned
Average of the unsigned values of a single field.
Copy
Makes a copy of a previous aggregation field.

Tip
Use Copy to create a second value of an aggregation field, that needs to be shown as a histogram with a different scale or name.

Copy First
Copies the first non-blank value.

Copy First Date
Copies the first valid date.

Copy First Numeric
Copies the first valid numeric.

Copy First Time
Copies the first valid time.

Copy Last
Copies the last non-blank value.

Copy Last Date
Copies the last valid date.

Copy Last Numeric
Copies the last valid numeric.

Copy Last Time
Copies the last valid time.

Count Blank
Number of blank values in the field.

Count Date
Number of valid date values.

Count False
Number of False values.

Count Inside Dates
Number of date values inside the range.

Count Inside Mean/SD
Number of numeric values inside the mean and an entered number of standard deviations.

Count Inside Numeric
Number of numeric values inside the range.

Count Inside Times
Number of time values inside the range.

Count Match
Number of times two fields or a field and an entered constant exactly match.

Count Negative
Number of negative values in the field.

Count Non-Blank
Number of non-blank values.

Count Non-Zero
Number of non-zero values.

Count Not Match
Number of times two fields or a field and an entered constant don't match.

Count Numeric
Number of valid numeric values in the field.

Count Outside Dates
Number of date values outside the range.

Count Outside Mean/SD


Number of numeric values outside the mean and an entered number of standard deviations.

Count Outside Numeric


Number of numeric values outside the range.

Count Outside Times
Number of time values outside the range.

Count Positive
Number of positive values.

Count Time
Number of valid time values.

Count True
Number of True values.

Count Zero
Number of zero values in the field.


Blank values are counted as zero.

Date Range
Difference between earliest and latest date values in the field expressed in days.

Divide
Divides one previous aggregation field by another.

Divide Constant
Divides a previous aggregation field by a constant.

Earliest Date
Earliest date value in the field.

Earliest Time
Earliest time.

Invert
Divides a previous aggregation field into unity.

Largest
Largest value.

Latest Date
Latest date.

Latest Time
Latest time.

Longest

Longest value as a string.

Lookup
A value is obtained from a lookup table.

Tip
Use Lookup to show values from a previous Daisy Chart.

Median
Median value of the field.

Multiply
Multiplies up to three previous aggregation fields together.

Multiply Constant
Multiplies a previous aggregation field by a constant.

Negate
Gets the negative value of a previous aggregation field.

Tip
Use Negate to show an aggregation field as two histograms, one positive and one negative.

Numeric Range
Difference between largest and smallest values in the field.

Skewness

Skewness of the field.

Smallest
Smallest value in the field.

Standard Deviation
Standard deviation of the field.

Subtract
Subtracts one previous aggregation field from another.

Time Range
Difference between earliest and latest time values in the field expressed as minutes.

Total
Total of the field.

Total Add
Total of up to three non-consecutive fields.

Total From-To
Total of the consecutive fields defined by from and to fields.

Total Multiply
Total of up to three non-consecutive fields multiplied together.

Tip
Use Total Multiply to create an aggregation field, that is based on a Quantity multiplied by a Rate.

Total Negative
Total of the negative values of a single field.

Total Positive
Total of the positive values of a single field.
Total Time
Total time of a single field.
Total Unsigned
Total of the unsigned values of a single field.

Variance


Variance of the field.

Weighted Average 
Average calculated by summing the first field and dividing it by the sum of the second.

% Blank etc.
Every count field is paired with a percentage field. These express the count as a percentage of the total number of records at the node.

Appendix C - Data Sheets

All of these data sheets were produced using the various Examples opened using Open Example in the File menu.
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Here the Software Test example has been selected.
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